
� �Readme  
 

___________________

___________________

___________________

 

  

  
Readme 

Programming and Operating Manual

 

  
11/2011 
  

General notes 
 1

 

STEP 7 Professional 
 2

 

WinCC Readme 
 3



 

 

Legal information 

 

Legal information 
Warning notice system 

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger. 

DANGER  
indicates that death or severe personal injury will result if proper precautions are not taken. 

WARNING  
indicates that death or severe personal injury may result if proper precautions are not taken. 

CAUTION  
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken. 

CAUTION  
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken. 

NOTICE  
indicates that an unintended result or situation can occur if the relevant information is not taken into account. 

If more than one degree of danger is present, the warning notice representing the highest degree of danger will 
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to 
property damage. 

Qualified Personnel 
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. 
Qualified personnel are those who, based on their training and experience, are capable of identifying risks and 
avoiding potential hazards when working with these products/systems. 

Proper use of Siemens products 
Note the following: 

WARNING  
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended 
or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed. 

Trademarks 
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner. 

Disclaimer of Liability 
We have reviewed the contents of this publication to ensure consistency with the hardware and software 
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the 
information in this publication is reviewed regularly and any necessary corrections are included in subsequent 
editions. 

 

 Siemens AG 
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90026 NÜRNBERG 
GERMANY 
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General notes  1
1.1 General notes 

The information in this readme file supersedes statements made in other documents. 

Read the following notes carefully because they include important information for installation 
and use. Read these notes prior to installation. 

Security settings 
In order to operate the software packages in the TIA Portal, port 4410 for TCP must be 
entered as an exception in the Windows firewall during installation. 

Installing new .Net versions or .Net service packs 
● Close the TIA portal before installing a new .Net version or a new .Net service pack on 

your programming device/PC. 

● Restart the TIA portal only after successful installation of the new .Net version or the new 
.Net service pack. 

Notes on handling 
● If a project in the list of projects last used is located on a network drive that is not 

connected, you may experience delays when opening the "Project" menu. 

● When you insert a CPU, you may need to wait for some time if the project editor is open 
at the same time. This generally takes longer when you insert the first CPU in a newly 
created project. To be able to continue working more quickly, you should close the project 
editor before inserting a CPU. 

● The message "Application is not responding" may appear in Windows 7 with functions 
that take a long time to run (loading the CPU for example). If this occurs, wait until the 
function has correctly finished. 

● If you have installed a Microsoft mouse with IntelliPoint, you may find that it 
superimposes components over the buttons of the title bar. If this is the case, uninstall the 
IntelliPoint software from Microsoft. 

● Enabling the "Virtual Desktop" options with NVIDIA graphics cards can cause problems. 
In this case, disable the "nView virtual desktop manager" of your NVIDIA graphics driver. 
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Changes to keyboard shortcuts for menu commands   
To enable country-specific characters to be entered in TIA portal V11, the assignment of 
keyboard shortcuts to menu commands has been changed as follows (Ctrl+Alt is the same 
as AltGr): 

 
Previously Now Menu command 
<Ctrl+Alt+A> <Ctrl+Shift+P> Rewire tag 
<Ctrl+Alt+B> <Ctrl+Shift+M> Set/delete bookmarks 
<Ctrl+Alt+D> <Ctrl+U> Accessible devices 
<Ctrl+Alt+F> <Ctrl+M> Cancel online connection 
<Ctrl+Alt+G> <Ctrl+Shift+Q> Stop CPU 
<Ctrl+Alt+I> <Ctrl+Shift+I> Define tag 
<Ctrl+Alt+K> <Ctrl+Shift+F> Go to > Next point of use 
<Ctrl+Alt+L> <Ctrl+Shift+G> Go to > Previous point of use 
<Ctrl+Alt+N> <Ctrl+Shift+U> Rename tag 
<Ctrl+Alt+O> <Ctrl+K> Going online 
<Ctrl+Alt+R> <Ctrl+Shift+Z> Start Runtime 
<Ctrl+Alt+T> <Ctrl+Shift+E> Start CPU 

Using the TIA Portal via a remote desktop 
In principle, it is possible to use the TIA Portal via a remote desktop connection. During 
configuration, you should, however, avoid disconnecting the connection to the desktop client. 
In rare cases, this can lead to the software user interface being blocked. 

If you experience this blockage, follow these steps on the desktop client. 

1. Open the Windows Task-Manager and close the "rdpclip.exe" process. 

2. Type in "rdpclip.exe" in the command prompt to restart the process. 

Note that the current content of the clipboard will be lost. You can, however, then continue 
configuration as usual. To be on the safe side, you should restart the TIA Portal at the next 
opportunity. 

Opening the TIA portal multiple times 
If you are running several applications of the TIA portal and they continually become active 
in turn, you can briefly switch to another application or use the key combination <ALT+Tab> 
to solve the problem. 

Note on SD cards 
The SD cards have been formatted and initialized by Siemens for use with S7-1200 
modules. This format must not be overwritten otherwise the card will no longer be accepted 
by the S7-1200 modules. Formatting with Windows tools is therefore not permitted. 



 General notes 
 1.1 General notes 

Readme 
Programming and Operating Manual, 11/2011 7 

Behavior in case of open force job    
Note that active force jobs will be retained even after you have loaded a new project to the 
SD card. This means you should first delete the active force job before you remove an SD 
card from the CPU and before you overwrite the card in the PC with a new project. If you use 
an SD card with unknown content, you should format the SD card before the next download. 

Issues when shutting down Windows XP or when activating a screen saver      
Windows XP uses the ACPI (Advanced Configuration and Power Interface) to shut down the 
computer or to go to standby mode. It can happen that while the system is processing a 
newly installed tool that the screen saver is not activated by the ACPI or that after exiting the 
tool that Windows XP cannot be shut down properly. 

If the TIA Portal is running, the Standby function of the computer is deactivated. To put the 
computer into Standby, you have to first exit the TIA Portal.  

The following description shows several optional settings in the "Power Options Properties" 
you can use to set the Standby mode of the computer with the function "Hibernate": 

1. In Windows XP, open the "Power Options Properties" by pointing at "Start > Settings > 
Control Panel > Power Options" and select the tab "Hibernate". Select the "Enable 
hibernation" check box. 

2. Switch to the "Advanced" tab. In the "Power buttons" dialog, click the drop down list box 
under "When I close the lid of my portable computer:" and select the option "Hibernate". 

3. Then click the drop-down list box under"When I press the power button on my computer:" 
and select the option "Shut down". 

4. Click "Apply" and confirm the settings with "OK". 

5. Afterwards, restart the PC. 

If you experience problems shutting down the computer, make sure that the TIA Portal has 
closed completely. 

1. In the shortcut menu, select the Task Manager from the shortcut menu on the Taskbar. 

2. If you see the process "Siemens.Automation.ObjectFrame.FileStorage.Server.exe" in the 
"Processes" tab, wait until this process has closed. 

3. Then you can shut down the computer. 

Subnet addressing for CP 1613 and CP 1623 
CP 1613 and CP 1623 are communication modules with microprocessor. To ensure secure 
management of communication links, these are processed on the module. The protocol 
stack in your PC is used for diagnostic purposes (SNMP, DCP). To allow both protocol 
stacks (i.e. CP 1613/23 Firmware and CP 1613/23 NDIS access) access to the same 
partners, is recommended to place both stacks of a module in the same subnet. 
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Editing a device IP address   
Do not use the address range from 192.168.x.241 to 192.168.x.250 when editing a device IP 
address. If necessary, this address range is automatically assigned by the system to a 
programming device. Depending on the subnet mask, this applies also for all network 
classes. 

Migrating projects with the TIA Portal 
After the migration of hardware configurations and program blocks from earlier automation 
solutions, first check the functionality of the migrated project before you use it in productive 
operation. 

Screen display 
After long periods of work, it can happen in the case of certain computer configurations with 
Windows XP that parts of the TIA Portal interface are no longer updated. Reducing the 
graphic hardware acceleration can correct this problem. You can find the setting for this by 
clicking on the desktop and selecting "Properties > Settings > Advanced > Troubleshoot > 
Slider Hardware acceleration" by means of the right mouse button. In this dialog, move the 
slider "Hardware acceleration" gradually to the left and apply this setting until the contents of 
the screen are displayed correctly again.  

Tablet PCs 
For the TIA Portal V11, tablet PCs are only released with the operating system Windows 7, 
not with Windows XP. 

SQL Server 
During the installation of the SQL Server 2005 or the SQL Server 2005 Express, an error can 
occur if the product SQL Server 2008 is already installed on your system. 

In order to be able to use both varieties of the SQL Server in parallel, the SQL Server 2005 
must be installed before the SQL Server 2008. To do this, follow these steps: 

1. Remove the SQL Server 2008 version, without deleting the databases. 

2. Install WinCC. The SQL Server 2005 is hereby installed and set up on your system. 

3. Install the SQL Server 2008 again. Now you can continue to use the databases already 
created in the SQL Server 2008. 
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Working with automatically synchronized network drives   
Automatic synchronization after a network interruption can result in current (local) project 
data being stored as a "backup" on the network drive through user interactions. This could 
cause outdated project data to be loaded from the network drive when opening the project. 
For this reason, we do not recommend that you store TIA Portal projects on synchronized 
network drives.  

If, however, you do work on synchronized drives, you can continue working locally in the 
event of a network interruption. In this case, you must always ensure that the TIA Portal 
application is closed while data is synchronized. The synchronization itself must be 
implemented in such a way that the current (local) project data replaces the project data on 
the network drive.  

Entry of decimal places   
With certain Windows language settings, it may occur that the entry of values with a comma 
as decimal place is not recognised (entering "1,23" leads to an error). Instead, use the 
international format ("1.23"). 

FAQs on the TIA Portal 
FAQs on the TIA Portal are available at http://support.automation.siemens.com 
(http://support.automation.siemens.com/WW/view/en/28919804/133000).  

 

http://support.automation.siemens.com/WW/view/en/28919804/133000�
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1.2 Notes on the installation 

Contents  
Information that could not be included in the online help. 

Target directory of the installation 
Do not use any UNICODE characters (for example, Chinese characters) in the installation 
path. 

Installation of STEP 7 Basic V11 and STEP 7 Professional V11 under Windows XP with Turkish 
Regional and Language Options 

Installation of STEP 7 Basic V11 and STEP 7 Professional V11 under Windows XP may be 
cancelled, if the regional and language options are set to Turkish. In this case change the 
regional and language options from Turkish to English or German. 

1. Open the Control Panel under Windows with one of the following commands: 

– "Start > Control Panel" (Start menu under Windows XP) 

– "Start > Settings > Control Panel" (classic start menu) 

2. Open the "Regional and Language Options". 

3. Select the "Regional Options" tab. 

4. Under "Standards and formats" select "German" or "English" in the drop-down list. 

5. Click "Apply" and confirm with OK. 

6. Restart your PC for the setting to become active. Now you can continue with the 
installation of STEP 7 Basic V11 and STEP 7 Professional V11. 

7. After installation, you can revert the regional and language settings (as described in steps 
1 to 4) to Turkish. 

Removing 
In rare cases removal of the program can cause the computer to freeze, even when a full 
version of SQL Server 2005 is installed. In this occurs, disconnect the computer from the 
network to continue the removal process. 
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Installation of the SIMATIC USB driver under Windows server 2003 R2 StdE SP2 
An operating system message relating to the SIMATIC USB driver is issued on the operating 
system Windows Server 2003 R2 StdE SP2. This message must be acknowledged with 
"Yes" as soon as possible after the message has been issued. The message may be in the 
background and therefore may not be immediately visible. After a certain period of time, the 
setup continues with the next component. The SIMATIC USB drivers are then not installed 
and cannot be used. 

Display of the desktop icon 
If you do not select the standard installation path during the installation of the TIA portal, the 
desktop icon may not be displayed correctly. This does not affect the functionality of the 
product. 



General notes  
1.3 Use of communications processors 

 Readme 
12 Programming and Operating Manual, 11/2011 

1.3 Use of communications processors 

Contents 
Information that could not be included in the online help. 

SIMATIC NET DVD for PC communications processors    
The use of the SIMATIC NET DVD versions listed below is recommended for the following 
communications processors depending on the operating system: 

● CP 1613 

● CP 1613 A2 

● CP 1623 

● CP 5613 

● CP 5614 

● CP 5613 A2 

● CP 5614 A2 

● CP 5623 

● CP 5624 

The following versions of the SIMATIC NET DVD should be used with the stated operating 
systems: 

● Windows 7 (Professional, Enterprise, Ultimate), 32- and 64-bit and Windows Server 2008 
R2 

"SIMATIC NET PC Software" DVD V8.1 SP1 

● Windows XP, Windows Server 2003 and Windows Server 2008, 32-bit. 

"SIMATIC NET, PC Software, Edition 2008 + SP4" CD, version number V7.1.4. 
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Operation of communications processors   
If both STEP 7 V5.5 and STEP 7 V11 are installed on a computer and STEP 7 V5.5 is 
removed, the setup repair function of STEP 7 V11 must be executed before the following 
communications processors can be used as network adapters for loading firmware: 

● CP 561x 

● CP 5613 A2 

● CP 5614 A2 

● CP 5623 

● CP 5624 

● CP 5711 

See also 
Service & Support (*** NO TRANSLATION IN THIS VERSION! ***) 
(http://support.automation.siemens.com/WW/view/en/12660737) 

http://support.automation.siemens.com/WW/view/en/12660737�
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STEP 7 Professional 2
2.1 Notes on use  

Contents  
Information that could not be included in the online help. 

Online operation   
The simultaneous online operation of STEP 7 V5.5 or earlier and STEP 7 Professional V11 
has not been approved. 

Simultaneous online connections on an S7-1200 CPU    
It is not possible to establish an online connection from multiple TIA portal instances 
simultaneously to the same S7-1200 CPU. 

Parallel use 
If the term "Combo" appears in the name or license key of the software after installation, the 
use of the following products/versions is permitted in accordance with Article 1.6 of the 
General Terms and Conditions (see also setup text): 

● STEP 7 Professional 2010 

● STEP 7 Professional 2006 

Configuring and assigning module parameters   
For an overview of the modules you can configure and assign with STEP 7 Professional V11 
go to http://support.automation.siemens.com 
(http://support.automation.siemens.com/WW/view/en/28919804/133000).  

Documentation on S7-PLCSIM   
S7-PLCSIM is installed together with STEP 7 Professional. The documentation is saved 
centrally. 

You can find the manuals under: C:\Programs\Siemens\Documentation\Product notes  

You can find the readme files under: C:\Programs\Siemens\Documentation\Readme 

http://support.automation.siemens.com/WW/view/en/28919804/133000�
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Removing/inserting the memory card   
After removing or inserting a memory card, always perform a memory reset on the CPU in 
order to restore the CPU to a functional condition. 

Deleting a WinAC RTX from a SIMATIC PC    
A controller application WinAC RTX with an assigned onboard CP interface in an interface 
slot (IF) cannot be deleted from a SIMATIC Box PC/Panel PC/Rack PC. If you wish to delete 
the WinAC RTX, you must first remove the onboard CP interface from the interface slot. To 
do this, the onboard CP interface must be selected in the network or device view and a 
different option (for example, "Windows only" or "SIMATIC PC station") must be activated in 
the inspector window under "CP assignment" instead of the option "SIMATIC WinAC".  

Removing and inserting Ethernet modules     
If Ethernet modules are removed and re-inserted during operation, you must boot the PC; 
otherwise, the "Accessible devices" functionality in STEP 7 or NCM PC will not display all 
devices. While the PC boots, Ethernet modules must be activated. 

Notes on the information system 
The following functions are already described in the information system, but are not available 
in STEP 7 Professional V11.0 SP2: 

● Loading hardware configurations from the target system to the PG/PC. 
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2.2 Editing devices and networks  

2.2.1 General information on devices and networks  

Contents  
Currently, there is no general information available on devices and networks. 

2.2.2 Use of modules on the S7-1200  

Contents  
Information that could not be included in the online help. 

Use of modules on the S7-1200 
The modules listed below are not supported on the S7-1200.    

 
Series Module Order number 

SM 338 6ES7 338-4BC01-0AB0 
FM 350-1 6ES7 350-1AH03-0AE0 
FM 350-2 6ES7 350-2AH00-0AE0, 6ES7 350-2AH01-0AE0 
FM 351 6ES7 351-1AH01-0AE0, 6ES7 351-1AH02-0AE0 
FM 352 6ES7 352-1AH02-0AE0 
FM 355 S 6ES7 355-1VH10-0AE0 
FM 355 C 6ES7 355-0VH10-0AE0 
FM 355-2 C 6ES7 355-2CH00-0AE0 

S7-300 FMs 

FM 355-2 S 6ES7 355-2SH00-0AE0 
CP 340 6ES7 340-1AH02-0AE0, 6ES7 340-1BH02-0AE0, 6ES7 

340-1CH02-0AE0 
S7-300 PtP-CP 

CP 341 6ES7 341-1AH01-0AE0, 6ES7 341-1AH02-0AE0, 6ES7 
341-1BH01-0AE0, 6ES7 341-1BH02-0AE0, 6ES7 341-
1CH01-0AE0, 6ES7 341-1CH02-0AE0 

Network component Diagnostics 
repeater 

6ES7 972-0AB01-0XA0 
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Series Module Order number 
1 Count 24 V 6ES7 138-4DA04-0AB0 
1 Count 5 V 6ES7 138-4DE02-0AB0 
1 Step 5 V 6ES7 138-4DC00-0AB0, 6ES7 138-4DC01-0AB0 
2 pulses 6ES7 138-4DD00-0AB0, 6ES7 138-4DD01-0AB0 
1 SI 6ES7 138-4DF01-0AB0 
1 SI Modbus 6ES7 138-4DF11-0AB0 
1 SSI 6ES7 138-4DB02-0AB0, 6ES7 138-4DB03-0AB0 
1 Pos Universal 6ES7 138-4DL00-0AB0 

ET 200S 

SIWAREX 7MH4910-0AA01, 7MH4912-0AA01, 7MH4920-0AA01 
ET 200M SIWAREX 7MH4 900-2AA01, 7MH4 900-3AA01, 7MH4 950-

1AA01, 7MH4 950-2AA01 

2.2.3 Using clock memories  

Contents  
Information that could not be included in the online help. 

Clock memories are deactivated when the CPU is replaced  
The clock memory is deactivated after you have replaced a CPU of the S7-300, S7-400 or 
ET 200 by another CPU by using the "Replace device..." function. If you want to use the 
clock memory, activate it again in the CPU properties in the inspector window.  
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2.2.4 Replacing the ET 200S pulse generator and positioning modules  

Contents  
Information that could not be included in the online help. 

Replacing the ET 200S pulse generator and positioning modules    
This information is relevant to the "2 Pulse" pulse generator modules (6ES7 138-4DD00-
0AB0) and "1 Step 5V" positioning modules (6ES7 138-4DC00-0AB0) from a project which 
was created with TIA Portal V11.0. When replacing these modules from the TIA Portal V11.0 
with a new version of these modules, the parameter settings are reset to the default values. 

This is the case with one of the following procedures: 

● Replacting the pulse generator module 6ES7 138-4DD00-0AB0 or the positioning module 
6ES7 138-4DC00-0AB0 with their successor modules 6ES7 138-4DD01-0AB0 or 6ES7 
138-4DC01-0AB0 by means of a device replacement. 

● Updating the module version using the appropriate button in the device properties in the 
Inspector window. 

2.2.5 Setting flow control for CM 1241 (RS232)  

Contents  
Information that could not be included in the online help. 

Values for XON and XOFF     
If flow control is enabled for the CM 1241 (RS-232) communications module and set to 
"XON/XOFF", you can enter identical values for the XON and XOFF characters. From a 
technical point of view, however, this configuration is impractical. You should therefore use 
different values for XON and XOFF.  
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2.2.6 Removing and plugging Ethernet modules  

Contents  
Information that could not be included in the online help. 

Removing and plugging Ethernet modules 
Ethernet modules, for example USB network cards, must already be plugged and activated 
at the system start. When Ethernet modules are deactivated or do not exist at the system 
start or are removed and plugged again during operation, the "Available nodes" functionality 
does does display all the nodes in STEP 7 or NCM PC. This also applies to the change of 
docking stations when the Ethernet module is not plugged in the notebook but rather in the 
docking stations.    

Activate the deactivated Ethernet modules by using "Control Panel > Network Connection" 
and reboot the system. Also reboot the system if Ethernet modules were plugged during 
operation or if the docking station with the Ethernet module was changed during operation. 

2.2.7 Notes on online and diagnostics  

Contents  
Information that could not be included in the online help. 

Hardware detection followed by online connection   
When the "Online > Hardware detection" command is performed for an unspecified CPU, the 
online configuration is not loaded from the CPU. If you do not load the configuration resulting 
from the hardware detection to the CPU, the device and network views will always show a 
difference between the offline and online configurations. It will appear there are different 
configurations in the online and diagnostic views, although the MLFBs are identical in the 
actual CPU and the offline CPU. 

Assigning an IP address   
If an IP address is assigned directly to a PLC via the diagnostics and online function with 
"Functions > Assigning an IP address", this IP address will be set permanently and retained 
even after a restart or power failure. 
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Creation of the system diagnostics blocks  
The block numbers set for the created system diagnostics blocks must not overlap existing 
block numbers. Moreover, the numbers must not overlap the numbers of blocks located in 
libraries. 

If problems occur in the generation of blocks, check whether the preset numbers (FB 49, 
DB 49, FC 49, DB 50) have been changed. If this is the case, try to repeat the generation 
with the preset block numbers or use numbers which you are certain are not in use 
elsewhere. 

2.2.8 Compiling the hardware of a pulse generator  

Contents  
Information that could not be included in the online help. 

Compiling with a disabled pulse generator    
If a pulse generator is deactivated and the following error message nevertheless appears 
during compilation of the hardware "Pulse generator as: PTO cannot be selected. Associated 
high speed counter not correctly configured.", follow these steps:  

1. Deactivate the high-speed counter. 

2. Activate the pulse generator and set the operating mode to "PTO". 

3. Deactivate the pulse generator. 

4. Recompile the hardware. 
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2.2.9 Special feature CP 1616 / CP 1604: Configuration variant "Migration"  

Contents  
Information that could not be included in the online help. 

CP 1616 / CP 1604 
 You can use the CP 1616 / CP 1604 alternatively as follows: 

● Only PROFINET IO Controller 

● Only PROFINET IO device 

● PROFINET IO device and PROFINET IO controller 

Special feature when using as "Only PROFINET IO device" 
Install a suitable GSDML file for the CP and use those components in the catalog without the 
additional designation "(Migration)". 

 

 Note 
When do you need the component with the additional designation "(Migration)"? 

You only need the component with the additional designation "(Migration)" in the following 
case: 
 You use the CP simultaneously as PROFINET IO device and PROFINET IO controller; 

and 
 You configure the higher-level PROFINET IO_Controller in a "third-party tool" and have to 

integrate the CP used as PROFINET IO device into this "third-party tool". 

Components with the additional designation "(Migration)" are not required for complete 
configurations within the TIA portal.  
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2.2.10 IO routing with CP 1616 / CP 1604  

Contents  
Information that could not be included in the online help. 

CP as PROFINET IO router - what this means in practice 
You can operate a PC station with the CP 1616/CP 1604 as PROFINET IO router by 
employing the relevant CP as PROFINET IO device and PROFINET IO controller 
simultaneously. This IO routing allows process data to be exchanged between two 
PROFINET IO systems. If the configuration is set up correctly the CP can, for example, allow 
certain process level inputs and/or outputs to be accessed at control level. 

In a typical configuration the CP then simultaneously satisfies the following functions: 

● PROFINET IO Device for a higher-level PROFINET IO controller of the control level 

● PROFINET IO controller with connected IO devices for the subordinate process level 

Assign configuration - transfer area "TM" (transfer module mapping)     
In the configuration, select the "IO device" option under "Operating mode" . 

The additional "I-device communication" configuration area appears, in which you can make 
the settings for the IO routing. There you specify the type and the size of the transfer area for 
IO routing to the higher-level IO controller under "Transfer area detail". 

The following options are available for the "Transfer area type": 

● CD: Controller Device 

Select this option to specify a transfer area between the IO controller and IO device. 
Refer to additional information on this in the online help under "Configuration for 
PROFINET IO". 

● TM: Transfer module mapping 

Select this option for the IO router application. An additional configuration area with the 
name specified appears in the Inspector window under "Operating mode / I-device 
communication". In this configuration area make the assignment for the transfer module 
mapping in the mapping table. 
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Transfer module mapping 
Transfer modules represent the data areas routed from the lower-level IO system into the 
higher-level IO system. 

Enter the IO devices from the lower-level IO system in the mapping table in accordance with 
your requirements.. 

The table contains the following columns: 

 
Parameter Meaning 
Offset Offset in relation to the first bit in the transfer module. 

The specification has the form <Byte>.<Bit>. 
Example: 0.5 

Device/module (slot) Specification of the IO device 
The displayed dialog shows the IO devices configured on the IO system. 

IO type Select the IO type via the drop-down list box. 
The selection options depend on the transfer module type. 

Start Start address (offset) in the data area of the IO device. 
The specification has the form <Byte>.<Bit>. 
Example: 0.0 

End End address (offset) in the data area of the IO device. 
The specification has the form <Byte>.<Bit>. 
Example: 8.0 
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2.3 Programming a PLC  

2.3.1 General notes on PLC programming  

Contents  
Information that could not be included in the online help. 

Downloading inconsistent programs to a device   
In TIA portal, it is not possible to download inconsistent programs to a device without a 
consistency check. During the loading process, all blocks of the program are implicitly 
checked and are compiled again in the event of inconsistencies. If, however, there are 
programs on your CPU which were loaded with earlier versions of STEP 7, these programs 
could demonstrate inconsistencies.  

In this case, note the following: 

If you load an inconsistent program from a device, you will not be able to load the program 
unchanged to the device afterwards, because a consistency check always takes place 
during the loading process and existing inconsistencies are corrected. 

Loading data blocks from a device   
Please note that the two CPU families handle the values of tags differently when loading 
blocks from a device. 

● S7-1200 

CPUs of the S7-1200 series store the start values with which a data block is loaded to the 
CPU in the load memory. If you load a data block from an S7-1200 CPU, these start 
values are applied from the load memory to the offline data block again. Even if you have 
made value changes in the load memory during runtime by means of the "WRIT_DBL" 
instruction, the values originally loaded to the device are applied to the offline data block. 

In order to apply the current monitored values from the CPU, you can use the function 
"Snapshot of the monitored values". You can find detailed information on this in the 
information system, in the section "Programming data blocks".  

● S7-300/400 

CPUs of the series S7-300/400 also store the start values with which a data block is 
loaded to the CPU in the load memory. However, they cannot read the values back from 
the load memory. If you load a data block from a device, the current monitored values are 
loaded from the CPU and entered in the "Start values" column in the offline data block.  

Copying overlaying tags    
Tags that overlay other tags using the keyword "AT" cannot be copied. In this case, copy the 
overlaid tag and define the overlay again on the copy. 
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Importing organization blocks from external STL/SCL sources   
CPUs of the S7-300/400 series accept organization blocks with any name during import. If 
you import an OB with a standard name (for example, CYCL_EXC or CYC_INT5), it is 
automatically assigned to the correct OB class. If you import an OB with an unknown name, 
an OB0 is created. You can change this number after the import and hereby assign it to the 
desired OB class. To change to the OB number, select "Properties" in the shortcut menu. 

Process image of PTO/PWM outputs  
Do not use PTO/PWM outputs in the process image (for example, for accesses in the user 
program, for online functions or in HMI). The update rate of the process image is much 
slower than the rate of the signal changes. The display in the process image does not reflect 
the signal flow. 

Moving system blocks     
Moving objects from the "System blocks" folder to the "Program blocks" folder is not 
permitted in STEP 7 V11.0. 

Conversion of know-how protected blocks from V10.5   
After the conversion from V10.5 to V11.0, the program must be compiled. If you use know-
how protected blocks, you are prompted to enter the password. 
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2.3.2 SCL  

Contents  
Information that could not be included in the online help. 

MUX: Multiplexing    
As of V11 SP2, parameter numbering of the MUX instruction no longer begins with IN0 but 
with IN1.  

If you want to import the MUX instruction from a source of a previous version of the TIA 
portal, please correct the calls by increasing the parameter numbers of each call by 1. 

Implicit data type conversion    
The data type DINT is no longer implicitly converted to REAL in SCL. Instead, use the 
explicit conversion function DINT_TO_REAL, for example: 
"tag_real1" := "tag_real2" + DINT_TO_REAL("tag_dint"); 

Compatibility of SCL blocks (S7-300/400)   
SCL blocks that were created with STEP 7 V11.0 or V11.0 SP1 can be continue to be 
processed and loaded in V11.0 SP2.  

However, SCL blocks that were created with STEP 7 V11 SP2 can no longer be processed 
or loaded with STEP 7 V11.0 and V11.0 SP1. 

Format for null pointers   
The following format is no longer supported for null pointers: 
MyVar:= NIL; 

Instead, use the format universally valid for STEP 7: 
MyVar:= P#P0.0 VOID 0; 

No textual input of the instructions CONVERT, T_CONV and S_CONV possible 
  

The basic instruction CONVERT and the extended instructions T_CONV and S_CONV 
cannot be input in text form and used in an SCL block. Instead, enter the conversion 
functions according to the pattern <source type>_TO_<target type>. 

  
Example: #str := INT_TO_STRING( #value ); 

  
If, however, you drag and drop the instructions CONVERT, T_CONV or S_CONV into the 
SCL editor, a dialog opens automatically in which you can define the data types to be 
converted 
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2.3.3 Instructions  

Contents  
Information that could not be included in the online help. 

MODBUS library     
The instruction "MB_SLAVE" was updated in STEP 7 V10.5 SP2.  

If you have already used "MB_SLAVE" V1.0 in a project that was created with STEP 7 V10.5 
SP1, you must manually replace this version with the new version MB_SLAVE" V1.1 after 
the installation of STEP 7 V11. 

To do this, follow these steps: 

1. Delete "MB_SLAVE" V1.0 from all blocks in the project. 

2. Delete "MB_SLAVE" V1.0 from the project library. 

3. Insert "MB_SLAVE" V1.1 in all required locations of use. 

4. Compile the project. 

Using instructions with parameters of type VARIANT in logic blocks with different access types 
(S7-1200)    

Logic blocks (FBs/FCs) and data blocks (DBs) can be created with different access types 
("standard" and "optimized"). In logic blocks, you can call any instructions. Certain 
instructions (for example, "WRIT_DBL" and "READ_DBL") use pointers of type VARIANT at 
input and output parameters to address data blocks. 

Ensure that you do not use these instructions in programs in which logic blocks of different 
access types are called reciprocally. This could cause the following to occur: 

● A structure from a standard data block is directly or indirectly passed to an optimized 
logic block, which forwards this structure directly or indirectly to one of the blocks 
mentioned above. 

● The reverse scenario, whereby a structure from an optimized logic block is directly or 
indirectly passed to a standard data block, which forwards this structure directly or 
indirectly to one of the blocks mentioned above. 

SCL language harmonization in the TIA portal    
As of V11 SP2, parameter numbering of the MUX instruction no longer begins with IN0 but 
with IN1.  

If you want to import the MUX instructions from a source of a previous version of the TIA 
portal, please correct the calls by incrementing the parameter numbers of each call by 1 
accordingly. 
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TM_MAIL and AS_MAIL instructions - transfer of data for the AUTH-LOGIN authentication process  
The user name (USERNAME parameter) and password (PASSWORD parameter) are each 
transferred to the mail server unencrypted (BASE64-coded). 
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2.3.4 Testing the user program  

2.3.4.1 Testing with the watch table  

Contents  
Information that could not be included in the online help. 

Multiple access to the same CPU   
Access to a CPU from a PG/PC is permitted only when a TIA portal is open. Multiple access 
to the same CPU is not permitted and can lead to errors.  

Rounding floating-point numbers   
In the watch table, floating-point numbers are stored as binary numbers in IEEE format. 
Since some floating-point numbers (real, long real) that can be displayed in the user 
interface cannot be mapped exactly to the IEEE format, it is possible that floating-point 
numbers will be rounded. 

If a floating-point number has been rounded for this reason and it is then copied to another 
input cell in the watch table, the rounding may result in a slight deviation. 

Loading data blocks during an active control job   
 

NOTICE  
Loading changed data blocks during an active control job can result in unforeseen 
operating states. The control job continues to control the specified address, although the 
address allocation may have changed in the data block. Complete active control jobs 
before loading data blocks. 

 

Testing programs converted from STEP 7 V10.5. 
To monitor and test a program converted from STEP 7 V10.5, you have to first compile and 
load with STEP 7 V11.0. 
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2.3.4.2 Testing with the force table  

Contents  
Information that could not be included in the online help. 

Forcing tags for direct I/O access    
If you use direct I/O access for an S7-300 CPU in your user program, forcing this I/O 
address is not permitted. 

Example 
If I/O access to the address "IB0:P" takes place in the user program, it is not permitted to 
force the following I/O address areas: I0.0:P, IB0:P, IW0:P and ID0:P. 
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2.4  Technological functions  

2.4.1 Notes on technological functions (S7-1200) 

PID_3Step Variable Retain.Mode  
In this documentation, Mode = 7 is described as operating mode "Approach substitute output 
value with error monitoring" and Mode = 8 as operating mode "Error monitoring". 

The correct information is: 

● Mode = 7 is the "Error monitoring" operating mode 

● Mode = 8 is the "Approach substitute output value with error monitoring" operating mode 

PID_Compact V1.0 
PID_Compact V1.0 is out of date. A CPU with firmware V2.0 is required as of PID_Compact 
V1.1. Update the CPU firmware and select a newer version from the Task Card 
"Instructions". 

2.4.2 Notes on technological functions (S7-300/400)  

Parameter assignment for the FM x51 and FM x52  
In contrast to the information in the Online Help, if you change the measuring system, the 
previously entered parameter values are not converted to the new measuring system. 

Programming FM x50-1, FM x51 and FM x52 
The "initial values" specified in the parameter tables in the online help regarding the 
instructions correspond to the "default value" in the software interface of the user 
programming. 

FM 355, FM 355-2, FM 455 
To commission the modules you have to first establish an online connection and then start 
the measurement. Contrary to the description, the online connection is not established at the 
start of the measurement. 

FM 355-2 multiple instance DBs 
If you use multiple instance DBs in your project, you must commission the FM 355-2 via a 
watch table. 
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PID Self Tuner 
If you call the instructions TUN_ES and TUN_EC as multiple instance DB, no commissioning 
interface is available. In this case, you must commission the controller via a watch table. 

IM 174 migration 
During the migration of projects with IM 174, the parameter assignment of IM 174 is set to 
default values. It is absolutely necessary to set parameters for IM 174 again after the 
migration. 
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WinCC Readme 3
3.1 Security information 

Secure operation of a plant 
To ensure secure operation of a plant, you have to take suitable security measures, 
including IT security (network segmentation, for example). More information on Industrial 
Security is available on the Internet (www.siemens.com/industrialsecurity). 

 

NOTICE  
Various passwords are set by default in WinCC. For security reasons, you should change 
these passwords. 
 For the Sm@rtServer and for the integrated Web server, the default password is "100". 
 For the user "Administrator", the default password is "administrator". 

 

 

http://www.siemens.com/industrialsecurity�
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3.2 Notes on use 

Contents 
Information that could not be included in the online help. 

Parallel installation in the TIA portal 
You will be prevented from starting the TIA portal if you set up a non-permitted parallel 
installation of STEP 7 and WinCC. 

The following parallel installations are permitted in the TIA portal: 

● STEP 7 V11 and WinCC V11 

● STEP 7 V11 SP1 and WinCC V11 SP1 

● STEP 7 V11 SP1 with WinCC V11 SP2 

● STEP 7 V11 SP2 and WinCC V11 SP1 

● STEP 7 V11 SP2 with WinCC V11 SP2 

Both Engineering Systems must always have the same version after an installation. 

A dialog opens during installation to inform you of any inconsistencies in your parallel 
installation.  

Parallel installation of WinCC V11 and WinCC V7 
Parallel installation of WinCC V11 Professional or Runtime Professional with WinCC up to 
V7.0 (including service packs) is not approved. 

Copying HMI devices with HMI connections 
If you copy an HMI device with HMI connections to a PLC, the HMI connection in the new 
HMI device will not automatically be connected to an existing PLC with the same name. This 
statement applies to copying within a project as well as copying across projects.    

To access the PLC tag via HMI tag in the new HMI device, you will have to complete the HMI 
configuration immediately after the copying step. Proceed as follows: 

1. Open the "Devices & Networks" editor. 

2. Connect the new HMI device with the desired network. 

3. Open the connection table. 

4. Select the HMI connection of the new HMI device. 

5. Select the desired PLC under "Partner". 

If you compile the new HMI device or connect additional PLC tags in between copying the 
HMI device and completing the connection, there may be some instances in which you 
create an additional HMI connection to the same PLC. This is especially true if you connect 
HMI tags with DB array elements. 
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Device replacement 
After an HMI device has been replaced, you should check the appearance of the configured 
screens. Changing the size of the display may result in changes to the position and 
appearance of screen objects, e.g. recipe view and alarm view. 

Device replacement - communication 
If an HMI device is replaced, error messages of the type "... will not be supported in the new 
configuration. It will be removed" will be issued. These alarms refer to configured 
connections of the device and are triggered, for example, if the HMI devices have a different 
number of interfaces. These connections are marked red after a device replacement. If you 
would like to continue to use these connections, you have change the configuration of the 
connection. Proceed as follows:   

1. Open the "Devices and Networks" editor. 

2. Click "Network" in the toolbar of the network view. 

3. Network the interface of the HMI device with the interface of the CPU. 

4. Click in the tabular area of the network view on the "Connections" table. 

5. Select the connection marked red. 

6. Enter the new interface under "Properties > Properties > General > Interface" in the 
Inspector window. 

Specifying the time of modification in the overview window 
The times of modification displayed in the overview window only refer to changes to the 
object itself. Changes to subordinate objects, e.g. screen objects in a screen, do not cause 
the time of the last change to the screen to change in the overview window.   

HMI device wizard 
When you create a device with a color display using the HMI device wizard, the graphics of 
the navigation buttons may be displayed in black and white. This error only occurs, however, 
if the new device is created with the same name as a device with a monochrome display 
which has been deleted in the meantime. 

You can avoid this error by always deleting the associated graphics in the Graphics 
collection whenever you delete a device from the project. 
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Objects with object references in the project library 
Two copying methods can be used in WinCC flexible.   

● With "simple copy" a WinCC flexible screen including an IO field, for example is copied. 
Only the object name of a tag configured on the IO field is copied, as this is a reference. 

● With "copy", a screen, an IO field contained there and a tag configured on the IO field 
together with its properties are copied. 

These two methods can also be used for storing an object in a library. Project libraries and 
the objects contained there are migrated during migration and can be used in WinCC. 

In WinCC, however, only one copying method is available. With regard to tags, it functions 
like "simple copy" in WinCC flexible. With regard to graphics, graphics lists and text lists, it 
functions like "copy" in WinCC flexible. 

If you stored objects with references to tags in a library in WinCC flexible, you must 
reconfigure the referenced objects when using them in WinCC. 

Installing East Asian project languages on a PC without Asian operating system 
If you select an East Asian project language on a PC that does not have an Asian operating 
system installed, the default font will be marked as invalid in the "Runtime settings > 
Language & font" editor. 

To resolve this problem, open the "Regional and Language Options > Languages" dialog in 
the Control Panel and select the "Install files for East Asian languages" option. 

Transferring licenses to a panel on 64-bit operating systems 
If you are running a 64-bit operating system and the "Edit > Connect target systems > 
Connect HMI device" menu command is not available in Automation License Manager, open 
command line input and run the following command with administrator rights: 

"%WINDIR%\system32\RegSvr32.exe" 
"%CommonProgramFiles%\siemens\AlmPanelPlugin\ALMPanelParam.dll" 



 WinCC Readme 
 3.3 Migration 

Readme 
Programming and Operating Manual, 11/2011 39 

3.3 Migration 

Contents 
Information that could not be included in the online help. 

 

 Note 

The most efficient way to locate scripting errors in the course of the initial test run after 
migration is to use an installed Script Debugger and the diagnostics controls. 

 

Changing the names of alarm classes 
In contrast to WinCC flexible, the names of the predefined alarm classes are not dependent 
on the user interface language currently in use. During migration, the names of the alarm 
classes are assigned as follows: 

 
WinCC flexible WinCC 
Error Errors 
System System 
Warnings Warnings 

The display names of the alarm classes can be changed as necessary after migration. 

Project languages in WinCC 
WinCC V11 does not support all project languages that were available in WinCC flexible, 
such as Arabic. If you receive an empty project as the result of your migration, you may want 
to check the set editing language. Do not set the project languages that are not supported as 
editing language in the source project. Proceed as follows: 

1. Open the project with WinCC flexible. 

2. Change the editing language to English, for example. 

3. Save the project. 

4. Restart the migration. 
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Objects with object references in the project library 
Two copying methods can be used in WinCC flexible.  

● With "simple copy", a WinCC flexible screen including an IO field, for example, is copied. 
Only the object name of a tag configured on the IO field is copied, as this is a reference. 

● With "copy", a screen, an IO field contained there and a tag configured on the IO field 
together with its properties are copied. 

These two methods can also be used for storing an object in a library. Project libraries and 
the objects contained there are migrated during migration and can be used in WinCC. 

In WinCC, however, only one copying method is available. It functions like "simple copy" in 
WinCC flexible. 

If you have stored objects with references to other objects in a library in WinCC flexible, you 
must reconfigure the referenced objects when using them in WinCC. 

Migrating an integrated project with ProTool objects 
The "PROTOOL option package(s) missing in STEP 7" error message output during 
migration of a WinCC flexible project that is integrated in STEP 7 indicates that WinCC 
flexible 2008 SP3 is installed on your system. Moreover, the project still contains objects that 
were configured using ProTool. Do not open the project with WinCC flexible 2008 SP3! 
Proceed as follows to migrate the project: 

1. Copy the project to a computer on which WinCC flexible 2008 SP2 and STEP 7 are 
installed. 

2. Open the project in the SIMATIC Manager. 

3. Remove all ProTool objects from the project. 

4. Execute the "Save as" command in the "File" menu. 

5. Activate the option "With reorganization" in the "Save project as" dialog. 

6. Click OK. 

7. Copy the project back to the original computer. 

8. Restart the migration. 

Migrating a WinCC V7 project with "Chinese (Taiwan)" Runtime language 
If your WinCC is installed with support for the "Chinese" user interface language, the texts 
and report layouts of the "Chinese (Taiwan)" Runtime language will not be included when 
you migrate WinCC V7 projects. Migrate such projects using the Migration Tool, or a PC that 
contains a WinCC setup without "Chinese" user interface language. 

Progress bar 
As long as the progress bar still shows a value of 100 %, the software is still busy running 
remaining tasks such as the closing of references. The software will not respond to user 
input while this status is given. 
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3.4 Engineering System 

3.4.1 Screens and Screen Objects 

Contents 
Information that could not be included in the online help. 

Text format of output fields in alarm text 
It is not possible to underline tags and text list entries. 

Copying display objects between two projects or two devices 
In Project_1 configure an alarm window in the Global Screen, for example. You copy the 
alarm window and paste it in the Global Screen in Project_2.        

The enabled alarm classes are partly not enabled in the alarm window after pasting. 

This behavior applies to the following display objects: 

● Alarm window 

● Alarm indicator 

● Alarm view 

Representation of the cross-references in the Inspector window 
The Inspector window displays objects used by a screen object in the "About > Cross-
reference" tab. 

A screen is open and an object selected. You are using an HMI tag at the object as process 
tag. 

The object and the linked HMI tag are displayed in the cross-references. All locations of use 
of the object and the HMI tags are listed. 

If the HMI tag is interconnected with a PLC tag or a DB tag, then the locations of use of the 
interconnected PLC tag or DB tag will be displayed.    
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Event names in case of alarms in the "Info" tab of the Inspector window 
In some alarms of the Inspector window the event names in the "Info" tab will deviate from 
the names in the "Properties" tab.     

 
Name in the "Properties" tab of the Inspector 
window 

Name in the "Info" tab of the Inspector window 

Cleared ClearScreen 
Loaded GenerateScreen 
Enable Activate 
Change Change 
When a dialog is opened ONMODALBEGIN 
When a dialog is closed ONMODALEND 
User change PASSWORD 
Screen change SCREEN 
Disable Deactivate 
Press Press 
Outgoing Going 
Incoming Coming 
Limit "high limit error" violated AboveUpperLimit 
Limit "low limit error" violated BelowLowerLimit 
Click Click 
Loop-In-Alarm LoopInAlarm 
Release Release 
Alarm buffer overflow OVERFLOW 
Acknowledge Acknowledgement 
Runtime stop Shutdown 
Press key KeyDown 
Release key KeyUp 
Switch ON SwitchOn 
Switch OFF SwitchOff 
Value change Change value 

Dynamization of object properties in a group 
The dynamization of properties for all objects of the group which have these properties is not 
possible in a group. In WinCC V11, the properties of the objects beloning to a group can only 
be dynamized for each object itself.  
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Illegible characters in Runtime Professional 
With Runtime Professional, only characters belonging to the language area which is defined 
with the operating system setting "Language for non-Unicode programs" can be displayed on 
the target system. Texts with characters from other language areas can, however, also be 
configured in the project. 

Illegible characters may occur in the Engineering System with the objects text field, symbolic 
I/O field, gauge and slider if the settings in the operating system relating to "Language for 
non-Unicode programs" do not match the selected editing language and the objects are 
displayed in a different design than "WinCC Classic". The characters are displayed correctly 
in the Inspector window and the "Project texts" editor. 

Therefore, first check in the Control Panel under "Regional and Language Options > 
Advanced" whether the setting for "Language for non-Unicode programs" is the same as the 
editing language. Otherwise, you can check or change the correct texts in the Inspector 
window or the "Project texts" editor. 

Faceplates 
Faceplates cannot be rotated or mirrored. 

Persistence with display objects in WinCC Runtime Professional 
The objects f(t)-trend view, f(x)-trend view, alarm view, recipe view, table view and value 
table have settings for the persistence of online configurations. If you have configured 
"Persistence" for "Online configuration" and "Keep changes" for "Reaction to screen 
change", you can make changes to the configuration dialogs in runtime which will be 
retained after a screen change and after runtime is exited. 

However, online configurations for the settings mentioned cause changes to the 
configuration of the objects in the Engineering System to only be applied in Runtime if you 
recompile the device with the command "Compile > Software (rebuild all)". 

Basic Panels, OP73, OP77A and TP177A: Displaying texts in runtime  
The default font selected in the "Runtime settings > Languages & font" editor has an effect 
on the display of texts in runtime.  

Text entries may be truncated if you selected an unfavorable font size or style. 

This setting possibly has an effect on the following text entries: 

● Tooltips 

● long alarm text 

● text in the dialogs 

Tab sequence in screens with faceplates 
If you configured a tab sequence in screens with faceplates in WinCC V11 or WinCC V11 
SP1, you should check the tab sequence of these screens in WinCC V11 SP2. The tab 
sequence may have been changed in both the screen and the faceplate. 
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Tag prefix of a screen window in WinCC Runtime Professional 
The objects of the "Controls" palette do not support the tag prefix that can be configured for 
a screen window. 

I/O field with "decimal" display format and format pattern without "s" prefix 
You have linked a process tag to an I/O field. The I/O field is assigned the "decimal" display 
format.    

You may select a signed or an unsigned display format. 

A "Display format" setting without "s", e.g. "999" has the following effects: 

1. You cannot set negative values using the I/O field in Runtime. 

2. If the tag assumes a negative value, the I/O field generates a two's complement and a 
corrupted positive value is output. 

Trend view on Basic Panels 
The trend view buttons are not displayed on Basic Panels. You can operate the trend view 
using the function keys of the HMI device that are assigned corresponding system functions. 
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3.4.2 Tags and connections 

Contents 
Information that could not be included in the online help. 

Tag names 
HMI tag names may not start with the character @. 

Display of deleted array elements at location of use of HMI tags 
The locations of use of HMI tags, such as the process value of IO fields, are usually 
indicated by the tag name. If the element of an array tag is used, then the tag name will be 
extended by the index of the array element indicated in brackets. 

If a used tag is no longer included in the project, then the tag name will still be displayed at 
the location of use. The field will be displayed with a red background to indicate the missing 
tag. If a used array element or the array tag is no longer present, then only the index of the 
array element will be displayed in brackets. The tag name will not be displayed. The field is 
highlighted in red. You can no longer identify the name of the associated array tag based on 
the location of use in this instance. 

If you do not know which array tag was linked to this location of use, then it may be 
necessary to link the array element once again. 

If a tag or array tag was created based on a reference, then the selected reference will be 
closed automatically. 

If an HMI tag is connected with an array element of a PLC tag and the PLC tag does no 
longer exist in the project, then the same behavior will take place in the "HMI tags" editor.     

Array tags as list entry of multiplex tags 
You can use the array tags of the Char data type just like the tags of the String data type.     

The use of an array tag of the Char data type as list entry of a multiplex tag in the "HMI 
tags" editor is not supported.  

Multiplexing tags on a Basic Panel 
If you multiplex a tag with an external tag on a Basic Panel, the address is read from the 
PLC in runtime during the first read cycle. The value of the address read is not available until 
the second read cycle. 
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Runtime Advanced and Panels: Importing array elements and structure elements 
Array tags and structure tags are always imported in full with all elements. The elements of 
the array tags and structure tags are not filled further during import. 

A new tag is created if the name of a tag corresponds to the name of an array or structure 
element in the import file. 

Example: 

The import file contains an array tag called "Otto" with 10 array elements. The array 
elements are then called Otto[1], Otto[2], for example. 

If the import file contains a tag called "Otto[1]", the first element of the array tag will not be 
filled. Instead, a new tag will be created in the Engineering System. 

Local ID of HMI connections 
You cannot edit the "Local ID" value in the HMI connection properties. You need the local ID, 
for example, for communication by way of AR_SEND. To enable usage of the "Local ID" for 
communication, proceed as follows: 

1. Open the network view in the "Devices & Networks" editor. 

2. Click "Connections". 

3. Select an S7 connection. 

4. Select the "Add new connection" command in the shortcut menu of the PLC. 

5. Click on the interface. 

6. Specify the "Local ID (hex)". 

7. Click "Add" and then "Close". 

8. Select "Properties > General" from the partner area of the Inspector window and enter the 
IP address of the HMI device for the new connection. 

9. Configure the necessary raw data tags for communication in the HMI device. 
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3.4.3 Alarm system and alarm displays 

Contents 
Information that could not be included in the online help. 

Displaying special characters in alarm texts 
When configuring alarm texts, a fixed character set is used in the Engineering System. This 
character set allows you to use numerous special characters in alarm texts.    

Language-dependent fonts are used in runtime to display the texts, for example MS PGothic, 
SimSun. The fonts used in runtime do not support all special characters. As a result, some 
special characters are not displayed in runtime. 

Use of multiplex tags in output boxes with alarm texts 
In the engineering system, it is also possible to use multiplex tags in the output boxes of 
alarm texts. During runtime, this leads to an incorrect display of the alarm, because the use 
of multiplex tags is not supported by the basic panels.    

3.4.4 System functions 

Contents 
Information that could not be included in the online help. 

The "SimulateTag" system function on Basic Panels 
If you use the system function "SimulateTag" with a short cycle time on a Basic Panel, the 
HMI device may be overloaded. 

3.4.5 Recipes 

Contents 
Information that could not be included in the online help. 
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3.4.6 User administration 

Contents 
Information that could not be included in the online help. 

SIMATIC Logon for WinCC Runtime Advanced and Panels 
When you use SIMATIC Logon to manage access to a panel or a device with WinCC 
Runtime Advanced, you must note that the characters [/] and [\] cannot be used in the 
names of Windows user groups or Windows users. 

3.4.7 Communication 

Content 
Information that could not be included in the Online Help. 

Opening projects in WinCC V11 (no service pack) with communication via Modicon Modbus RTU, 
Modicon TCPIP, Allen Bradley DF1 

The following HMI devices are affected: 

● OP 77A 

● TP177 A 

● Basic Panel 

A Modicon Modbus RTU, Modicon Modbus TCP/IP, or Allen Bradley DF1 connection you 
configured in WinCC for one of the devices mentioned above will be invalid after it has been 
opened. You need to reassign the protocol in WinCC V11 SP2. 

If you reassign the protocol in the "Connections" editor in WinCC, the tag address 
assignments will possibly get lost. 

You can prevent the loss of tag address assignments as follows: 

1. Create a new connection with this protocol and the relevant CPU type in the 
"Connections" editor. 

2. Replace the original connection with the new one in the "Tags" editor. 

3. Reconfigure the area pointers. 

4. Assign the new connection to all functions that you are possible using, e.g. "set 
connection mode". 

5. Delete the original connection in the "Connections" editor. 
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Connection interruptions with Mitsubishi PLCs 
After multiple connection interruptions, a situation may arise where all the connection 
resources of the Mitsubishi PLC are in use and the connection can no longer be established. 
It is recommended to check these connection resources in the PLC program of the PLC and 
also enable them again.   

Area pointer "Date/time" or "Date/Time PLC" 
If you use the area pointer "Date/time" or "Date/time PLC" in communication with an S7-
1200, you must use data type "DTL" in the configuration of the PLC.    

Accuracy of the "DTL" data type 
The "DTL" data type supports time information down to the nanosecond range. Because 
panels only support time information down to the millisecond, you will encounter the 
following restrictions when using the area pointers:   

● Area pointer "Date/time" 
For the transmission of time information from a panel to the PLC, the smallest unit of time 
is 1 millisecond. The value range from microseconds to nanoseconds of the "DTL" data 
type will be filled with zeros. 

● Area pointer "Date/time PLC" 
For the transmission of time information from a PLC to a panel, the range from 
microseconds to nanoseconds will be ignored. The time information will be processed on 
the panel down to milliseconds. 

Limited number of possible HMI connections 
An error message is displayed during compilation of a device indicating that the configuration 
of the HMI connection in the "Devices & Networks" editor is invalid. The reason may be that 
the maximum number of possible connections of the HMI device or PLC has been exceeded. 

Check the maximum number of available connections. Consult the device manuals of the 
devices you are using. 

Routed communication with S7 300/400 
The communication of connection partners in various subnets can be routed via the following 
links: PROFINET, PROFIBUS, MPI. 
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Using PROFINET IO with panel HMI devices 
When using PROFINET IO to connect the direct keys and LEDs of HMI devices to the PLC, 
you can define an offset for the address area of the inputs and outputs during configuration 
in HW Config. 

The following restriction applies when you use a PROFINET IO-capable CPU of the 400 
series with one of the HMI devices listed below: 

The offset for the start of the address area of the inputs must not be bigger than the offset for 
the start of the address area of the outputs. 

The restriction applies to the following HMI devices: 

● OP 177B 

● OP 277 

● Mobile Panel 177 

For the configuration of the address parameters, open the PLC with the CPU of the 400 
series in HW Config. Select the HMI device connected via PROFINET IO in the station 
window of HW Config. A table with the properties of the HMI device is displayed at the 
bottom of the station window in the detail view. Select the line containing the addresses of 
the HMI device in the table and open the object properties using the shortcut menu. 

Select the "Addresses" tab in the "Object properties" dialog. Configure the offset for the 
inputs under "Inputs > Start". Configure the offset for the outputs under "Outputs > Start". 

Exceeding value ranges with Mitsubishi MC and Mitsubishi FX 
With some data types, the communication drivers Mitsubishi MC and Mitsubishi FX do not 
check whether the value of a recipe tag exceeds the value range of the PLC tags. The data 
types affected are: 

● 4-bit block 

● 12-bit block 

● 20-bit block 

● 24-bit block 

● 28-bit block 

Area pointer Coordination in an OPC connection 
In principle, the area pointer Coordination can be used eight times in an OPC connection. If 
you have configured an OPC connection and automatically create another OPC connection 
using "Add", the area pointer Coordination is only displayed once in the newly created 
connection. In this case, you should change the communication driver of the connection. If 
you then set OPC again as the communication driver, the area pointer Coordination can 
again be used eight times. 
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Communication resources: SIMATIC S7 1200      
The SIMATIC S7 1200 controller provides six communication resources for HMI 
communication. 

The number of HMI connections that you can actually configure depends on the HMI devices 
that you connect with the SIMATIC S7 1200.  

One HMI Panel occupies one communication resource per connection. 
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3.5 Compiling and loading 

Contents 
Information that could not be included in the online help. 

Compiling and loading 
If internal errors or warnings occur during compiling, compile the complete project using the 
command "Compile > Software (rebuild all)" in the shortcut menu of the HMI device. 

Before you start productive operation with your project, compile the entire project using the 
"Compile > Software (rebuild all)" command from the shortcut menu of the HMI device. 

If you are using HMI tags that are connected to the control tags in your project, compile all 
modified blocks with the command "Compile > Software" in the shortcut menu before you 
compile the HMI device. 

Saving the WinCC project 
If you save a project in WinCC using the "Save As…" command, this has no effect on the 
name of the Runtime projects generated for the devices. If you do not adapt the target path 
of the devices in the "Extended download to device" dialog, the Runtime projects on the 
target devices will be overwritten. 

Settings for update of operating system 
If you select the command "Online > HMI device maintenance > Update operating system" 
from WinCC, you cannot change the settings such as the type of PG/PC interface or baud 
rate. The settings used during the last download are always used. 

To make changes to the settings, open the "Extended download" dialog using the "Online > 
Extended download to device" command and change the settings. When you click the 
"Load" button the changed settings are saved. 

Alternatively, you can perform an update of the operating system with changed settings with 
ProSave. You start ProSave via the Windows Start menu "Siemens Automation > Options 
and Tools > HMI Tools > SIMATIC ProSave". 

Incorrect installation of ProSave 
If you receive an error message during installation of ProSave when loading data to a target 
device or maintenance of an HMI device, then you cannot remedy this error using the repair 
function of setup. Remove ProSave via the Control Panel. Then start setup and install the 
"ProSave" component again.    
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Checking the address parameters 
During compilation of an HMI device in the project tree with the command "Compile > 
Software" in the shortcut menu, the address parameters of the HMI device, such as the IP 
address, will not be checked. If you want to ensure that the address parameters are checked 
as well, you will have to compile the HMI device in the "Devices & Networks" editor of the 
toolbar.   

Error message when downloading data to the PLC 
A panel and a PLC are connected and communicating with other.  

If a tag is accessed while downloading data from the panel to the PLC, an error message is 
displayed on the panel.    

Delayed reaction in the "Extended download to device" dialog 
If the settings in the "Extended download to device" dialog for "Type of the PG/PC interface" 
and "PG/PC interface" do not match the settings on the HMI device, this can result in the 
application not responding for up to a minute. 

    

Extended download with an S7-1200 and a Comfort Panel 
An S7-1200 PLC and a Comfort Panel are located in the same physical network as the 
PG/PC. You open the "Extended download to device" dialog for the Comfort Panel.  

If you activate the option "Show all accessible devices", it may occur that the application 
stops responding.   

OP77A, OP73, TP177A: Loading projects 
When loading a project to an HMI device, it can happen that Runtime is not automatically 
ended, even though "Remote Transfers" is activated in the Panel. 

If this happens, stop Runtime and manually set the transfer mode on the HMI device.     
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Loading a SIMATIC HMI application to a PC station 
The following circumstances ca n lead to an error message during the first load of a 
SIMATIC PC station: 

● A SIMATIC HMI application is configured in a PC station in the project 

– WinCC Runtime Advanced 

– WinCC Runtime Professional 

– WinCC Standby 

– or WinCC Client 

● The property "S7RTM is installed" is activated. 

Before you load a SIMATIC PC station for the first time, select the configured device 
HMI_RT (WinCC...) in the project navigation. Open the "Extended download to device" 
dialog and select the appropriate interface and parameter settings. Click "Load". 

You then load the PC station as normal.    
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3.6 Runtime 

3.6.1 Notes on operation in Runtime 

Contents 
Information that could not be included in the online help. 

 

CAUTION  
Ethernet communication 

In Ethernet-based communication, end users themselves are responsible for the security of 
their data network. The proper functioning of the device cannot be guaranteed in all 
circumstances; targeted attacks, for example, can lead to overload of the device. 

 

Special characters in the user view 
Special characters, such as / " § $ % & ' ?, are not permitted when entering a name or the 
password in the user view.    

Language behavior - Layout of screen keyboard 
The layout of the screen keyboard is not switched when the runtime language changes.    

Tag values exceed the maximum length    
You enter a character string in a string tag via an I/O field. If the character string exceeds the 
configured number of tags, the character string will be shortened to the configured length. 

Empty message texts 
Runtime is running with a project. The project is saved on a network drive. 

In the event of interruptions to the network drive connection, Runtime may attempt to load 
message texts from the network drive. 

In the event of disconnection, the alarm window or the alarm view remains empty. 

To avoid this, copy the project to a local drive before the starting the project in Runtime. 
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3.6.2 Notes on operation of panels in Runtime 

Contents 
Information that could not be included in the online help. 

Using the mouse wheel in Runtime 
The use of the mouse wheel in Runtime is not supported on all panels.  
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3.7 HMI devices 

3.7.1 Notes on HMI devices 

Contents 
Information that could not be included in the online help. 

If the PC goes into standby or hibernate mode while the transfer is in progress, the panel 
status after interruption of the transfer is not defined. 

TS Adapter with Ethernet interface 
If an HMI device is connected via Ethernet and a TS adapter, it can not be reset to factory 
settings.   

Simulation of the Basic Panels 
Use an output field in an alarm text to output an external tag. The content of the output field 
will always be displayed with "0" during simulation.   

Simulation with real PLC connection 
The access point used by the simulation is independent from the settings of the Engineering 
System and can only be altered in the Control Panel with the "Setting PG/PC Interface" tool. 
If the PLC connection is terminated right after the start of the simulation with alarm 140001, 
you should check the access point used by the simulation with "Setting PG/PC Interface". 

1. Double-click "Setting PG/PC Interface" in the Control Panel. A dialog opens. 

2. Select" "S7ONLINE" in the "Access point of application" field as standard for HMI. 

3. Select the interface in the "Interface Parameter Assignment Used" area. 

4. Exit the dialog "Setting PG/PC Interface" with OK 

Loading of projects without recipe data records 
You are using recipes in a project. You transfer the project to a Basic Panel without recipe 
data records.  

You may encounter inconsistencies if you have altered the structure of the recipe in the 
Engineering System and the device already held recipe data records. 

Check the consistency of the data records in this case. The device will not issue a note for all 
structural changes.     
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Floating point numbers on MP 277, MP 377, TP 177B 4'' and CP4 
Only floating point numbers in the range from 10-293 ... 10+307 are displayed correctly on the 
HMI devices MP 277, MP 377, TP 177B 4'' and CP4. If the tag value is outside this range, it 
is displayed as 0. 

USB device driver under Windows XP 
If a configuration PC with Windows XP and a Comfort Panel are connected via USB, the 
S7-USB driver may be reinstalled when the HMI device is restarted. The device settings may 
in this case not be restored. 

KP400 Basic, TP1500 Comfort, KP1500 Comfort, TP1900 Comfort, TP2200 Comfort 
The devices are already described in the online help, but cannot yet be configured in WinCC. 
To be able to configure these devices, you have to install the HSP that will be released soon. 

Mobile Panels V2 
If you use Mobile Panels V2 in a project, it is not possible to open the project with WinCC 
V11 SP1. This affects projects with the following devices: 

● Mobile Panel 277F IWLAN (RFID Tag) 

● Mobile Panel 277F IWLAN V2 

● Mobile Panel 277 IWLAN V2 

"Zone ID/Connection point ID" tag of a Mobile Panel 277 IWLAN V2 
The tag used for the "Zone ID/Connection point ID" must be of data type INT for Mobile 
Panel 277 IWLAN V2 devices. Adapt this data type if necessary when migrating a project. 

HMI devices with operating system Windows CE 5.0 or higher 
Owing to a modified client-server communication security setting, the time difference 
between the HMI device (client) and PC (server) must not exceed 1 day. If you back up 
recipe data from the HMI device on a network drive, for example, make sure that the time is 
set correctly on the PC (server) and the HMI device (client). 

HMI devices with high communication load 
S7 Diagnostics should be enabled if a Panel is assigned many connections to PLCs or other 
HMI devices. Otherwise, you will risk overload on the Panel. 

Device replacement in the Engineering System 
In the Engineering System, you replace a device with configured LED keys with a device 
without LED keys. Runtime start fails after you have transferred the project data to the 
device.  

For this reason, delete the LED key configuration before you replace the device. 
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